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Introduction

The Avant AIR+ represents a new era of ultra-compact screening audiometry for your office.
Compact yet rugged, this PC-Based system is USB powered and supports current ANSI and IEC
audiometric tests. This manual assumes that the system hardware, software and
drivers are installed and working properly. Please refer to the Avant AIR+

Installation Manual for assistance. The Installation Manual is included in the original Avant
AIR+ packaging in PDF format on the USB Flash Drive.

The scope of this manual is to get you “up and running” with your Avant AIR+. Please consult
the interactive Help System within the software for more detailed information of features and
functionality. To access this tool, press the F1 key at any time, or click the Help icon or text
menu with your mouse. Access these by clicking on the “Help” tab at the top of the screen,
and select “Help Topics”. Select an item from the list in the Index tab and click “Display”.
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The AVANT Audiometer Software Qverview

The AVANT Audiometer software can run stand-alone or from NOAH™ System or the TIMS®
NOAH-Compatible Office System.

Launching the AVANT Audiometer Software
Stand Alone NOAH

favamll AVANT

\_ 7 AUDIOMETER

o Double Click the AVANT e Launch NOAH. _
Audiometer shortcut on your e Launch Avant Audiometer module

Windows Desktop. following NOAH procedures.

Basic Software Options

Several options are available which allow the user to customize the AVANT Audiometer
Software to meet their needs.

Access these options from the File Menuon  The options may also be accessed from

the AVANT Audiometer Main Screen as the Audiometry Screen by clicking on
shown below. the Options text menu as shown
. below.
m Functicn Help
Print Setup...
Page Setup...
Clear Session Data ) 0Hz 65dB HL

|

Advanced Options...

Exit v
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f Options ﬂ rOpt'lo ns g

View |Sc:'eening Audiometry | MHA/HLS I Tymp I View  Screening Audiometry | MHA/HLS | Tymp |
— Plot Sroven FrzeirT Amow Bul'ton57‘ Default Test:
¥ Vertical Grid ¥ Canos Move Up by (dB): IE 3 Manual
V¥ Horizontal Grid ¥ Speech Sounds Move Down by (dB): I‘H] 3:
~Sight ——————— Language: ¥ Auto Sound Auto Screening

Style: IIJnes 'I |<Defa|.||t> j
Size: |5ﬂ' Fort Size: |12 vI

¥ Dual Plot Mode Default Ear: |F*jght =l || Advanced

¥ Enable Operator Headset
[V Reverse Ears Plot Curves Width: IMedium vI

Auto Thresholds

(i,

¥ Enable Talkback Microphone Transducers
¥ Maintain Plot Ratios ¥ Use Plot Antialiasing
ok | cancsl | Hep | OK | Cancel |  Hep |
The View tab allows you to set the default The Screening Audiometry tab sets the
appearance of the test environment. look and behavior of the Avant AIR+.

f Options u

View I.‘3::1'eenir'|g.w"\.l.ldi::nm.etr'_.r MHA/HLS  Tymp |

Scaling: |Auto -

¥ Auto Switch Modes

V¥ Interpolate Curve

V¥ Alow Muttiple Records

ok | Cancdl | Heb |

If your system has a Tympanometer connected, this tab will assist in configuring the look of
the display.

NOTE: Remember, more information is always available in the Interactive Help System by
clicking the Help Icon or pressing the F1 key.
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Assign Transducers

Option 1: On the Audiometry Options Option 2: You can change transducers by
screen click Transducers to assign specific  Right-Clicking on any transducer icon on
transducers to the audiometer outputs. the Screening screen.

=e Words, Limit: |25 vl ﬁ
‘ ¢¢
=1 P4 200
Mask With
' Change Transducer
— Cloze

Zancel | Hep |

The Transducers dialog box will then appear. Select the appropriate transducer for each
output.

r

Transducers M

Air Conduction: |DD45 j
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Advanced Options

B e o -
m Function Help
Print Setup...
Page Setup...

Clear Session Data

Options...

Advanced Opticns...

Exit

The Advanced Options screen allows you to
configure your system to meet your individual
clinical needs. It also provides MedRx
Technical Support with tools for helping you
troubleshoot technical issues. Access this
screen from the File Menu on the Avant Main
Screen as shown to the left.

The key features of each tab are described below. For more in-depth information, consult the
interactive Help system within the softwa(e by pressing the F1 key or clicking the Help icon.

Advanced Options

General ]Audm | Video | Tympanometry |

CD-ROM Drive: |D: ~

I Home Directory Calibration Data
Language

Device Manager
Cortrol Panel
System Information

oK Cancel ‘ Help |

The General Tab configures the overall
Avant AIR+ behavior with respect to other
Windows programs, specifically NOAH.

Genemw Audic  Video ITympanumeiry]

Otoscope Input

Altemative Input

Device: j

oK Cancel ‘ Help |

Advanced Options lﬂ

If your system has a Video Otoscope, the
Video tab allows you to select the
appropriate device driver.

D-0121406-C 01/2019

Advanced Options

General Audio ]\flden 1 Tympannmatry]

oli T30 - N | Speakers (MedRx AR+ hd

Input Device ‘ J
Output Mocer: [ MedFx Al =

Input Mocer ‘ J
Microphone Gain {dB}: |0 - Set Defaults | Audio Properties ‘

oK Cancel ‘ Help |

Use the Audio Tab to select the proper audio
device for your Audiometer. This tab also
provides access to the Windows Audio

controls.
Advanced Options. @
General I Audio I Video  Tympanometry I
Tympanometer: ’—_|

oK | cancsl | Hew |

If your system has a Tympanometer
connected, use this tab to identify it and
ensure the driver and software that control it
are correctly installed.




Preparing for Testing

Use the accessories provided with your Avant AIR+. Typical acceptable transducers are shown
on the “Transducer & Accessories” page in the Installation manual. Operator headsets for use
with the Avant AIR+ should have 32 ohms impedance and the speaker power should be at
least 50 watts. Air conduction transducers for use with this device should have an impedance
of 10 ohms. The speaker voltage should match the local mains voltage where the device is
used.

The Operator Headset with microphone is used by the device operator to communicate with

O\

the patient. The patient talks to the operator using the Talk-Back microphone.

Placing the Earphones on the Patient

Earphones (DD65)

1. Place the earphones on the patient’s
head so the center of the earphone
is directly over the opening of the ear
canal.

Adjust the headband so the earphones
remain in place, but be careful not to
make it so tight as to cause patient
discomfort.
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Device Maintenance

Annual re-calibration of the transducers used with the Avant Audiometer is recommended.
There are no user repairable components of this device. Refer to the Installation Manual for
care and cleaning instructions.

Performing Audiometric Testing

The screen shot below shows all the feature controls which are available on the Audiometer main
window. Depending on the features that have been enabled, on your device, some icons may not
be available. The sections of the manual that follow explain how to use these tools to perform
hearing evaluations using your Avant AIR+.

Avant Audiometer - Avant ATR+ - Screering Audiometry

Lo [ ]| 5 = a (1)

HL (dB) HL (@B) 1000Hz 65dB HL

\0740_( —
* \\
N
= = = = = F:uemr/( Hz) e = 2 L_‘ = = F:zuewoAHx) ‘
e
1. Test selection tool bar 8. Test Interrupter
2. Earselection 9. Back
3. Output selector 10. Help
4. Test Type Selector 11. Discard
5. Tone Type Selectors 12. Talk Over
6. Output Level Potentiometers 13. Legend
7. No Response Button
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Pure Tone Audiometry

Pure Tone Audiometry measures the patient’s peripheral hearing sensitivity, or the softest
levels they can hear pure tones at a variety of frequencies. These thresholds are plotted on a
standard graph called an audiogram. The AVANT Audiometer software controls the
hardware, stores the data (if running within NOAH or TIMS) and prints a standard audiogram
report. Pure tone Audiometry can be performed via earphones or a Bone Conductor (Bone
Conduction).

Prerequisites:

e Before performing audiometry, careful inspection of the ear canal should be
performed. This is best done with Video Otoscopy. After ensuring the ear canal is clear,
place the appropriate transducer on the patient.

Pure Tone Audiometry via DD65

B
1. From the main Audiometer Window, Click the oo button on the right side
menu bar.
2. By default, the e button will be selected once you enter the main

Audiometry Screen. Other default settings (based on typical clinical practice and
procedures) are:

a. RightEar

b. AC (Air Conduction)
c. Tone Stimulus

d. Continuous Tone

3. Instruct the patient that they will hear several very quiet (soft) tones (beeps) and that
they should signal (raise their hand, press the patient response button, etc.) as soon as
they hear it. Itis helpful to also say “even if it seems very far away”.

4. Begin at 1000 Hz in the Right ear (unless the patient reports better hearing in the left
ear).

@ Test
5. Present a tone at 60 dB by pressing the space bar or clicking the [+ button.

6. If the patient does not hear the tone (does not signal), raise the level 5 dB using the up
arrow on your keyboard and present again.

7. Repeat step 6 until the patient signals that they hear the tone.

8. When the patient signals they hear the tone, decrease the level by 10 dB and present
the tone again.

9. Repeat steps 6 through 8 until the patient responds to a tone at the same level 2 times
with the level ascending.

D-0121406-C 01/2019 10



10. Using the right arrow key, change the test frequency to 2000 Hz and repeat steps 5
through 8 to establish the threshold at 2000 Hz.

NOTE: If the threshold at 2000 Hz is more than 20 dB different (less than or greater
than) the threshold at 1000 Hz, repeat steps 5 through 8 at 1500 Hz (the
“half octave” between 1000 Hz and 2000 Hz).

11. Repeat steps 5 through 8 for 4000 Hz, 8000 Hz, 500 Hz and 250 Hz.
12. Repeat steps 5 through 11 in the opposite ear.

NOTE: The software automatically calculates the 3-frequency Pure Tone Average
(PTA) which is displayed above and inside the legend as follows:

PTA Right: 60dB

e 2 Conduction, Al=0%, PTA=G0

Auto Screening

In Automatic mode the operator has to define the test parameters and start the test. The test
will follow the automatic screening protocol. It will perform a single intensity hearing
screening.

Jﬁ Right Ear, Left Ear ﬁflx,
@ 1. Select the ear you want to start
e (:) B 2. Choose the test style from the drop

B Stat [~ down

To begin the Automatic Screening:

3 - 3. Click Start to begin

4. Watch the log of the patient
responses

@ 5. Clear Log as needed
8 Setup @

The person being tested will have to use the Patient Handswitch to make responses. The
person should be instructed prior to performing the test to respond as soon as possible
whenever the tone is heard in either ear, no matter how faint it may be.
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The test will keep a log of every frequency tested. If the test shows some inconsistent or
dubious results, it may need to be repeated manually or automatically for a particular
frequency.

The automatic screening test parameters are available on the Setup screen.

Screening Setup % ] You may customize the screening setup
3 Frequencies Sequence Signal r to SpeCiﬁc:
[~ 125Hz : [fore =] |
[ ot Test: [pothEars '~ e e Frequencies
I 500 Hz Presentation: |Continuous v r
[~ 750 Hz |
¥ 1000 Hz e Testears
[~ 1500 Hz o
Iv 2000 Hz . .
2000 Hz Screening Level (dB): | 40 - ° Slgnal type
[+ 4000 Hz £
[~ &000Hz
[~ 8000 Hz Help ® Level
Advorced x| cncd | || The Auto Screening will perform a single
L , : , , : , : ) intensity hearing screening.
rAd\ranced Screening Setup @1 Advanced SCI’eening
Tining Eents Setup will allow you to

Signal Duration (ms)

[0 [ Play Sound Test customize the signal
Sience Duraton (nsy: [3000 - [0 duration, silence duration

Respare Tt (s [300 and response timeout.

Log Level: |Mormal -

Help
OK. | Cancel |

Auto Threshold

In Automatic mode the operator has to define the test parameters and start the test. The test
will follow the automatic screening protocol as defined in I1SO: 8253-1.
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mk:@MSITStore:C:%5CProgram%20Files%20(x86)%5CMedRx%5CAvantAUDX%5CAvantAUD.chm::/Src/AA/AASetupS.htm

Test Al Frequencies

B Stan ud

3

(5

To begin the Automatic Screening:

1.
2.

Select the ear you want to start

Choose the test style from the drop
down

Click Start to begin

Watch the log of the patient
responses

Clear Log as needed

The person being tested will have to use the Patient Handswitch to make responses. The
person should be instructed prior to performing the test to respond as soon as possible
whenever the tone is heard in either ear, no matter how faint it may be.

The test will keep a log of every frequency tested. If the test shows some inconsistent or
dubious results, it may need to be repeated manually or automatically for a particular

frequency.

The automatic threshold test parameters are available on the Setup screen.

4 Thresholding Setup

=

You may customize the screening

Freguencies Test

W 125Hz Method: |Ascending -
¥ 250 Hz

o [ shortened
F 750 Hz ¥ Repeat 1KHz
v 1000 Hz Sequence

¥ 1500 Hz

T e Test: |Both Ears bl
¥ 3000 Hz

¥ 4000 Hz

v 5000 Hz

v 8000 Hz

Advanced

Signal

Type: |Tone had
Presentation: |Continuous

Help

OK | Cancel |

setup to specific:
o Test Method

e Frequencies

e Testears
e Signal type
The Auto Thresholds will

perform a threshold seeking

D-0121406-C 01/2019

formula and complete after 3
successful response button
pushes at one level.
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Advanced Threshold Setup allows for customization of various parts of the test. These
options will allow the clinician to adjust how the thresholds are determined, the
maximum presentation level, stimulus timing, bracketing steps, logging activity and
confidence deviation. Information on each of these items are found by clicking the
Help button.

1 1 1 1 1 1 L
i N

Advanced Threshelding Setup 2
Ascending Method Steps Timing
Level Up by {dB): |5 Signal Duration {ms): | 1500
Level Down By (dB): 10 Silence Duration {ms): | 1500 - | 2500

Response Timeout {ms): | 3000
Bracketing Steps (dB): | 5

Maximum Level Limits (dE) Confidence Deviation (+/-dB): | 10

AC: | 120 BC: |90

Events

[ Play Sound Test
ay Soun Help
Log Level: |Mormal - oK | Cancel |

Tinnometer (Optional)

Purpose of the Tinnometer

Tinnitus is experienced by millions of people worldwide. The Tinnometer is designed to
mimic the sounds of tinnitus in order to provide an accurate and flexible tinnitus assessment.
Tinnitus Assessment increases patient rapport with the clinician when an equivalent tinnitus
sound can be created. The Tinnometer can accurately create tinnitus sounds for fast and
reliable tinnitus assessment. All test results should be used to help counsel the patient on
their specific tinnitus and what the assessment has found.
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The Tinnometer test was developed to:

1. Break away from the traditional limitation of tinnitus assessment with an audiometer
Produce accurate and flexible sounds that mimic patient tinnitus

Provide extended frequency ranges to more accurately match tinnitus sounds
Decrease the time needed to complete a tinnitus assessment

Standardize reporting needed when completing tinnitus assessment

Allow clinicians to save and recall prior tinnitus assessments

N o A W

Provide general guidelines for implementing results into tinnitus sound therapies
provided by leading hearing aid manufacturers

Performing the Tinnometer Testing:

e C(lick the Tinnometer button from
@ the main Avant Audiometer main
screen.
Tinnometer

The following screenshot shows the key features of the Tinnometer:

1. Toggle Switch to Start/Stop stimulus 5. Area where description of items will
2. Sliders to control frequency, be displayed
bandwidth, slope and tempo of the 6. Channels designed to present
stimulus multiple types of tinnitus sounds
3. Slider to control the intensity of the 7. A graphical display of the sounds
stimulus being played for the patient. Stimulus
4. Buttons used in determining tinnitus and Audiogram (if done within Avant
match, threshold and minimum or Noah) are display in dB SPL

masking level

2..

B}

(D) emometar L

D-0121406-C 01/2019

15



Interactions with the patient are controlled as follows:

1. Patient response switch indicator 4. Undo
2. Patient monitor microphone 5. Toggle help section
3. Talk forward 6. Return to Avant

There are 3 Steps needed for Tinnitus Assessment with the
Tinnometer

1. Identify patient’s tinnitus by frequency, bandwidth, slope and tempo

2. Lower the identified tinnitus until patient threshold is reached

3. Raise the tinnitus level above the identified tinnitus intensity (widen bandwidth if
needed) until the patient states they no longer hear the tinnitus. Play stimulus for 60
seconds to ensure masking is achieved.

Step 1: Identify Patient’s Tinnitus

fledRx - Speakers (MedRx ARC Audio - A) - TinnoMete, 1. Start by selecting the tinnitus type that
Audio Qutput [ Tinnitus Type | Questionaire  Informati has been described by the patient. This is
Ringing an approximation of the tinnitus sound
. . Whisting your patient hears. Tinnitus type will
e provide a starting frequency, bandwidth
and slope to help speed up testing time.
Buzzing
Humming

2. Use the stimulus start/stop toggle to
present the selected signal to the patient.

D-0121406-C 01/2019 16



Frequency

20Hz 50Hz 125Hz 250Hz 500Hz 1k

CI———

1O

2k 4k 8k 120
Band
100
- Orm—i

= e e A G s S

16k 24k

"

~ Tinnitus
=

%

[l o

i

e

hreshold

3. Use frequency slider to match the

pitch of the patient’s perceived
tinnitus

4. Use volume slider to match patient’s

perceived intensity of tinnitus

5. Adjust bandwidth, slope and tempo
(for pulsating tinnitus or prevention of

adaptation) as needed

8.

Buttons to allow greater flexibility in
bandwidth and slope of tinnitus.
Allows the addition of high/low
frequency sounds independently
Allows for independent right/left
volume control

Press Tinnitus Level button once the
patient’s tinnitus is matched

Step 2: Find Identified Tinnitus Threshold

Level
Threshold

0 -

Volume .

60 Tinnitus
Level

40 =

0 Level
Threshold

ML

=2

D-0121406-C 01/2019

1.

2.
Step 3: Masking Tinnitus for 60 Seconds

1.

Use down arrow on your keyboard to
lower stimulus until patient states
they are no longer able to hear the
tinnitus.

Click Threshold Level button.

Use volume slider to increase
intensity of the stimulus until the
patient states they are no longer able
to hear their tinnitus.

NOTE: Lower levels of masking may be
achieved by increasing bandwidth of
the masking stimulus. Pulsating the
masking noise can prevent tinnitus
adaptation.

Press the MML button and continue
presenting stimulus until 60 second
countdown ends.

If patient begins to hear their tinnitus
within the 60 seconds, raise intensity
until masking is achieved and repeat
number 2.

17



Tinnometer Modulation Tab

The Tinnometer modulation tab is designed to simulate sound generators
when hearing aid demonstrations cannot be performed. The following are
controls used in Modulation.

[]Random E
[ Music 20 I‘
[[]Ocean modulatic o
@ - e I | — =
eed maodulation I] quency '“n(lu\allJ]II T
1. Type of modulation Sound 3. Frequency of modulation
2. Speed of modulation 4. Modulation volume range

To use the Modulation features within Tinnometer, you must first complete
the three steps involved with tinnitus assessment. Once tinnitus assessment
is complete, you can use modulation by:

T @ 1. Activating the channel in
O which the tinnitus
O6dB 484229 Hz ©66dB assessment was performed.
56dB Threshold Level 56dB
4SL  Relative Tinnitus Level  4SL|
105L Relative MML 105L
Low High
Band 0.15 0.15
in octave
slope 100 100
in %

2. Enter the modulation tab on
the right side of Tinnometer
software.
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["1Random

[ Music 20 I‘
"1 Ocean modulatic 0

— = 1 /= =

Level modulation

3. Adjust the modulation stimulus with sliders as a counseling tool for the
patient.

Tinnometer Audiometry Scan

The Tinnometer Scan tab is designed for various forms of air conduction
audiometry. There are three types of audiometry that can be performed with
Tinnometer. You can access the forms of audiometry with the buttons
located by the number 1 in the image below.

‘ BEKEZY |

|
|

‘ Scan |

| _\

| |

Audiogram |

Tinnometer Residual Inhibition (RI)

The Tinnometer RI tab is designed for Residual Inhibition (RI) testing for a
patient’s tinnitus. The controls in the RI tab are as follows:

‘‘‘‘‘‘‘‘‘‘‘‘‘‘‘ 1. Scale from 0-10 of
tinnitus bothersome
level
o 2. Timer to begin
. stimulus

3. Tracking of patient’s
tinnitus bothersome
level as a function of
time
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A complete tinnitus assessment must be performed prior to performing
testing in the RI tab. Once tinnitus assessment testing is completed, optional
residual inhibition testing can be performed with the following steps:

56dB Threshold Level 56dB

4SL  Relative Tinnitus Level  4SL]|

10SL Relative MML 10SL
Low High

Band 0.15 0.15

in octave
slope 100 100
in %

xdl

.@@@.@.@0..

D-0121406-C 01/2019

. Activating the channel in

which the tinnitus
assessment was performed.

. Select the RI tab on the

right side of the Tinnometer
software.

. Ask the patient the

bothersome level of their
tinnitus from 1 to 10 and
mark their response.

. Click the stop watch to

begin the masking stimulus
(stimulus to play for 60
seconds).

20



You will hear a masking neoise for 1 minute
Then the noise will suddenly stop
The patient will have to redefine his discomfort about every 30 seconds.

5. Stimulus will play for 60 seconds and automatically stop at the 60 second
point.

) ‘ , - Al EKP
PPPOPOPIOO®

6. When the stimulus stops the patient must redefine their tinnitus bothersome
level every 30 seconds. The bothersome level should decrease upon the
stimulus stopping and will increase with time.

7. The test continues until the bothersome level returns to pre-test level.

Tinnometer Report Printing

The Tinnometer has four reports available for printing: tinnitus assessment

report, manufacturer guidance report, questionnaire report and a channel

report.

The following are common features found across reports:

QMedri ™ Speaker 1. To generate your report,
N::u:ut Tinnitus type  Questionaire  Information  Lan se | eCt w p ri nter . ” frO m
open O the File menu.
Save
Manufacturer Guidance  »
Print v printer ...

Exit

D-0121406-C 01/2019 21



2. Select the paper style
us you are printing.

3. Confirm all patient
information is correct.

==.

4. Choose your print
preferences.

5. Change the zoom of your
print preview.

.

6. Print your Report.

Tinnitus Assessment Report

Tinnitus assessment reports are able to be generated after completing the
three steps to tinnitus assessment. Once all steps are complete you are able
to print a report

@l’Mfd“*-SM 1. To generate your tinnitus
-F' 0 t Tinnitu: tionai I i L
e utpu innitus type  Questionaire nformation an assessment report, Select

Mew

open O “printer ...” from the File

Save menu.

Manufacturer Guidance b

Print J printer ...

Exit
Channel 1 2. The “Channel” reports are the
Al channels | tinnitus assessment reports.
Graph Channel 1 Select the channel used for
oo Chonn 3 testing or All Channels when
Graph Channel 4 multi-channel testing is

completed.
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Haniek sl 3. Use the drop down box to
I = select a diagnosis for the

H%3.11 Tinnitus, right ear .
H33.12 Tinnitus. lef ear patient.

H%3.13 Tinnitus, balateral

|H93.19 Tinnitus, unspecified ear

Comments 4x60 characters 4. Comments can be entered in 4

separate lines with a
maximum of 60 characters.

5. Print the Report.

Manufacturer Guidance Report

Manufacturer guidance reports are designed to provide hearing aid sound
therapy guidance to a clinician based on tinnitus assessment results. Sound
therapy is an option to tinnitus treatment. We encourage all clinics to
develop a tinnitus treatment protocol that is in line with their tinnitus
treatment goals. Manufacturer guidance generated by the Tinnometer is
designed to be a starting point in sound therapy and each patient may differ
in preferred sound.

Manufacturer guidance reports are able to be generated after completing the
three steps to tinnitus assessment. Once all three tinnitus assessment steps
are complete you are able to print a report.

1. Select the manufacturer that
e D you would like to have printed
in your report.

Manufacturer Guidance  + Oficon
,

Print Phonak

Exit Signia

Bernafon
Sonic
Beltone

QeI Speakers G NG 2. To generate your tinnitus

Qutput  Tinnitus type  Questionaire  Information  Lan
New 0 assessment report, select
Open “printer ...” from the File
= menu.

Manufacturer Guidance v
Print 3 printer ...
Exit
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Channel 1

Channel 2
[RUR=IE I
Hearing Aid Guidance

rerEpC T
Graph Channel 2
Graph Channel 3
Graph Channel 4

Diagnosis Code

H%3.11 Tinnitus, right ear
H33.12 Tinnitus, left ear

H33.13 Tinnitus, bilateral
|H%3.19 Tinnitus, unspacified ear

Comments 4x60 characlers

Graph Channel Report

. Select “"Hearing Aid Guidance’

4

from the list of reports.

Use the drop down box to
select a diagnosis for the
patient.

Comments can be entered in 4
separate lines with a
maximum of 60 characters.

. Print the report.

Graph channel reports will print a patient report which displays an image of
the patient’s tinnitus with QR codes for YouTube videos that play a wind
modulation noise nearest to their tinnitus. To generate the report you must:

D MedR - Speakers (3~ USE Ao DEviEa]~ TrroVieir Ve

QOutput  Tinnitus type

Questionaire  Information  Lan

Mew

Open o
Save |
Manufacturer Guidance  »
Print * printer ...

Exit

D-0121406-C 01/2019

1.

To generate your tinnitus
assessment report, select
“printer ...” from the File
menu.
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Channel 1 2. Select “"Graph Channel” from
Channel 2

All Channels the list of reports. Select the

0 channel number which you
raph Channel 1 ’ ,

Graph Channel 2 used to match your patient’s

Graph Channel 3 . .

Graph Channel 4 tinnitus sound.

3. Print the report.

Questionnaire Report

Questionnaire reports will only show as an option once the questionnaire has
been completed. Once a questionnaire has been completed and you are
ready to print a report you must:

@ MedRx - Speakers (3~ USB Agio Device) - TinnoMeter Me P
1. To generate your tinnitus
New 0 assessment report, select
open “printer ...” from the File menu.
Save
Manufacturer Guidance 3
Print * printer ...
Exit
Channel 1 2. Select the name of the
All Channel i i
plChamels e qu_estlonnalre you want to
Graph Channel 1 print from the list of reports.

Graph Channel 2
Graph Channel 3

|THI

3. Print the report.
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Printing

Printing within the Avant Audiometer software is very simple.

Functinn Ear Output Aud

Open
Save

Clear Sezzion Data

Page Setup...
Print Setup...
Print Preview
Print...

Go Back Ctrl-Back
Exit Alt-F4
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From the File menu, click one of the following options:

Page Setup - Allows you to set margin sizes and the
default text header for your reports.

Print Setup - selects the printer you want the report
to be sent to.

Print Preview - Shows you what your report will look
like before you print it.

Print - Sends the report to the printer. This option
opens the Windows Print dialog which allows the user
to select any installed printer and modify the
properties (quality, number of copies, etc.) for the
print job.
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Limited Warranty

MedRx, Inc warrants this product to be free from defects in material and workmanship for
one year from the time of purchase. If this system fails to perform as specified during this

period, the purchaser is responsible for calling MedRx at (888) 392-1234 or (727) 584-9600.

The company's representative will advise the owner to either return specific components
or the entire system to:

MedRYx, Inc.
1200 Starkey Road #105
Largo, FL 33771 USA

MedRx will repair or replace any defective devices, fully test the system and/or
components and ship the system promptly back to the owner. There is no cost for the
repair or return shipping, provided the system is one year old or less and has not been
misused, abused or damaged. Such damage includes, but is not limited to, dropping,
exposure to excessive heat greater than 100°F and water/liquid damage.

Repair or replacement of the system as provided under this warranty is the sole and
exclusive remedy of the purchaser. MedRx shall not be liable for any consequential or
incidental damages or for breach of any express or implied warranty. Except to the extent
of applicable law, any implied warranty, merchantability or fitness of this product is
limited to the duration of this warranty.

MedRx will, at its discretion, service and repair out of warranty products at the purchaser's
request, charging for parts and labor as necessary.

The limited warranty is deemed void if software or hardware is installed on this product
which is not pre-approved by MedRx, Inc. Approved software includes NOAH™ and HIMSA
approved hearing aid manufacturer programming modules for fitting hearing aids.

MedRx, Inc is not responsible for problems resulting from installation of unapproved
software or hardware. In the event of unapproved software or hardware installed on the
system causing a conflict, MedRx will service the product for a fee to be determined at the
time of service.

Any extension of this warranty past the initial one-year warranty is subject to the
following (where applicable).

1. A $300 deductible per repair.

2. Extended warranty does not include cables, connectors or peripherals.

3. Extended warranty of the Video Otoscope covers optics only.
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